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About CDML Advanced Calculator 
 
Besides the functions of a standard calculator, the CDML Advanced Calculator provides users with the 
following features: 
⇒ a resizable Tape Display 
⇒ 5 Memory Functions 
⇒ 14 Financial Functions 
⇒ 11 conversion modes 
⇒ 7 Intra-System conversion modes 
⇒ Currency Conversions (with daily updates) 
⇒ Time/Date Calculations 
⇒ Base Conversions 
⇒ a Calendar with Daily Notes 
⇒ 34 Scientific Functions 
⇒ a Scientific Expression Evaluator 
⇒ a Foot/Inch Construction Calculator 
 
There are also many Convenience Features, such as: 
⇒ The RPN mode 
⇒ the Auto-Decimal mode 
⇒ the Adding Machine mode 
⇒ user-defined Toolbar 
⇒ user-defined number of Decimal Places 
⇒ 2 Percentage Calculation modes 
⇒ a Magic Number mode (a constant value for “What If” operations) 
⇒ Reminder Alarms 
⇒ Billing Functions 
⇒ Project Timer 
⇒ Special features for users of desktop 10-Key adding machines 
⇒ and many others 
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Easy Access 
 
In order to be less obtrusive, CDML Advanced Calculator will not appear in the Windows 
Task Bar when it is minimized.  There are two features in the CDML Advanced Calculator to 
allow you easy, instant access to the calculator while keeping it out of the way. They may be 
activated (or deactivated) from the Properties Menu. 
 
Show in Tray 
This feature is active by default.  When enabled you will see a small calculator icon appear in 
the bottom right corner of your screen.  At this point you can open any other application(s) 
and do your work.  When you need the calculator, just click with your left mouse button on 
the small icon and CDML Advanced Calculator will appear. 
 
If you right-click on the icon, you will see a menu of available choices.  From this menu you 
can Show or Hide the calculator, Remove the calculator from tray (hide the icon), Cancel 
(hide) the menu and Exit CDML Advanced Calculator.  From the same menu you can activate 
the following features: Base Conversions, Construction (Ft/In) Calculator, Currency Conver-
sions, Expression Evaluator, Scratch Pad, Set Alarms, Calendar,  Time/Date Calculations and 
the Project Timer. 
 
From the Properties Menu, you can use the Hide Main Window option to hide all traces of 
the CDML Advanced Calculator except the tray icon.  Even if the CDML Advanced Calcula-
tor is hidden, it will still appear when you click on the tray icon.  Another way to hide the 
CDML Advanced Calculator is by minimizing it.  
 
 
Stay On Top 
When this feature is active you will see a small window with a " Show CDML Calculator" 
message.  When you double-click on that window, the CDML Advanced Calculator will ap-
pear and the message will change to "Hide CDML Calculator".  When you double-click that 
window a second time, the CDML Advanced Calculator will disappear.  You can do the same 
by using the Hide Main Window option form the Properties Menu. 
 
Initially the small window will appear on top of the screen in the center, however you can 
move the window around by clicking on it and while holding down the left mouse button 
dragging it to where you want it to be.  Release the mouse button when you are satisfied with 
its new location. 
 
Show or Hide Number Keys, Tape and Toolbar 
If you are working with limited screen real estate, you may wish to hide certain parts of the 
calculator.  All of these features may be accessed through the Properties Menu (or the Tool-
bar). 
 
You can hide the whole bottom portion of the calculator (including the number, operator and 
conversion buttons) and use your keyboard, toolbar and the menus to do your work.  Another 
way to save space is by hiding the tape.  When you need to view the tape, just go back to the 
Properties Menu and select Show Tape.  All your work will still be reflected on the tape even 
if it's hidden.  Finally, you can hide the toolbar and use the keyboard and the menus.  If you 
hide all 3 of the aforementioned items, all you will see on your screen is the Readout and the 
menus. 
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The conversions come in handy when dealing with various international and time standards. The finan-
cial functions make it easy to derive various payments and dividends (i.e. Mortgage, credit cards, stocks, 
etc.). The scientific expression evaluator helps to process advanced mathematical expressions and to 
print them out with the result. The tape is useful for reviewing your work. 
 

NOTE:  You can start the CDML Advanced Calculator with the "/nic" command line parameter. This 
feature is useful if you want to call the calculator from an other program (i.e. Excel macro), do your cal-
culations and return the result to that program.
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Using the Calculator 
 
To use the CDML Advanced Calculator, you can click on the buttons or use the key-
board to enter numbers and operators.  You can also use the Tab key to move be-
tween buttons and press the Space Bar when you reach the button that you want.  
Operators can also be entered from the Operators Menu . 
 

The original calculator mode is Standard Calculator.  The current mode is displayed 
just below the number Readout, between then Next and Previous Mode buttons.  To 
change the mode to any of the nine  conversion modes, click on the Next Mode but-
ton (right) or the Previous Mode button (left).  The ToolTip for the Next Mode button 
will show you the upcoming mode.  The ToolTip for the Previous Mode button will 
show you the preceding mode. 
 

NOTE:  You can also switch modes from the Modes Menu. 
 

Any completed operation will be registered on "tape" (The Tape Display).  The "tape" 
is located above the Readout  and reflects everything that you did since you started 
the CDML Advanced Calculator or since you last cleared the tape.  The tape has 
many useful functions.  You can search the tape for a specific string or number.  You 
can print the tape, you can publish the contents of the tape to Notepad (standard 
Windows Notepad or any other program, depending on your settings) or you can just 
browse the tape to review your calculations. 
 

Most of the calculator functions can be accessed through the menus. 
 

Beneath the "0" button, you will see a small box displaying the modes you turned on.  
These modes are as follows: 
 

F = Financial Calculator Mode 
D = Auto-Decimal Mode 
A = Adding Machine Mode 
R = RPN Calculator Mode 
S = Show Percent Mode 
C = Carry Result Mode 
% = Percent for Number Mode 
M = Magic Number Mode 
- (minus sign) = Repetitive Subtraction Mode 
I = Imperial English Measures Mode 
T = Troy English Measures Mode 
E = Repeat Entry Mode 
W = Swap “+“ and “Enter” keys Mode 
O = Copy Formatted Mode 

 

The three buttons in the bottom-right corner are Help, About CDML Advanced Calcu-
lator and Exit CDML Advanced Calculator, respectively.  
 

Above the Tape, you will find a 9-button Toolbar.  To use the Toolbar, you must first 
configure what function you want each button to perform.  This is done by right-
clicking on the button you want to configure.  Once the Toolbar is configured, click 
the corresponding button to perform that function. 
 
HINT:     To view what function the button is configured for, see the ToolTips for  that 
button. 
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Using the Tape 
 

The tape is very useful in reviewing your work.  You can use your mouse to scroll up 
and down the tape or you can use the following commands.  (All of the following 
commands can be accessed through the Tape Menu.) 
 
Print Tape 
       Send contents of tape to the default printer 
       Ctrl-P key and the Print Tape option on the Tape Menu  
Publish Tape 
       Send contents of tape to Notepad or any other user-defined program 
       Ctrl-N key and the Tape to Notepad option on the Tape Menu 
Clear Tape 
       Clear tape contents 
       Ctrl-L key and the Clear Tape option on the Tape Menu 
Annotate Tape 
       Make notations on the tape 
       Ctrl-A, N or n keys and the Annotate Tape option on the Tape Menu 
Find on Tape 
       Search tape for any word or number 
       Ctrl-F key and the Find On Tape option on the Tape Menu 
Find Next 
       Repeat last search 
       F3 key and the Find Next option on the Tape Menu 
        
Aside from the aforementioned functions, you can use your mouse to highlight the 
text on the tape and copy it to the Windows Clipboard.  You can modify the Tape 
Display Settings through the Set Properties screen. 
 
NOTE:  When you are using the Find on Tape feature, the found item will be high-

lighted.  If you repeat the search the next matching item will be highlighted.  If 
there are no other matching items, the first matching item will be highlighted.  If 
there are no matching items at all, you will be notified. 

 
 

Standard Calculator Operators 
 
Add 
       + key and the + button 
Subtract 
       - key and the - button 
Multiply 
       *, x, X keys and the X button 
Divide 
       / key and the / button 
Equal (Total) 
       =, Enter (!) keys and the = button 
Percent 
       % key and the % button 
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Square 
       S, s, ^ keys and the x2 button 
Square Root 
       R, r keys and the x½ button 
Decimal Separator (Period) 
       . key and the . button (you can also use a comma or whatever your geographi-

cal format dictates) 
 

Using Memory Functions 
 

To help you with complex calculations we included Memory Functions in the CDML 
 Advanced Calculator.  There are a total of 5 memory functions.  If memory is set,  
you will see a Check Mark appear to the left of the readout.  You will also see, in  
the bottom left corner, the word "Memory:" and the memory value next to it.  When  
you clear the memory contents, the check mark and the memory value display will  
disappear.  The 5 memory functions are as follows: 
 
Memory Store 
       Stores the currently displayed number in memory 
       Ctrl-M key combination and the MS button 
Memory Recall 
       Displays the number from memory 
       Ctrl-R key combination and the MR button 
Memory Add 
       Adds the currently displayed number to the number stored in memory and 

stores the new value 
       M (capital 'M') key and the M+ button 
Memory Subtract 
       Subtracts the currently displayed number from the number stored in memory 

and stores the new value 
       m  (small 'm') key and the M- button 
Memory Clear 
       Clears the memory 
       The MC button 
 

 
Clearing Entries in CDML Calculator 

 
Clear (Start Fresh) 
       c, C and Escape (Esc) keys and the C button 
Undo Last Digit 
       Back Space (") key  
Clear Entry (Undo Last Entry) 
       Delete (Del) key and the CE  button 
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Other Valid Keys in CDML Advanced Calculator 
 
Annotate Tape / Select All Text on Tape 

Ctrl-A or N and n keys and the Annotate Tape option on the Tape Menu. 
Construction Calculator (ft/in) 

Ctrl-B key and the Construction Calculations option on the File Menu. 
Copy Readout to Clipboard 

Ctrl-C key and the Copy option on the Edit Menu. 
Expression Evaluator 

Ctrl-E or ( keys and the Expression Evaluator option on the File Menu. 
Find on Tape 

Ctrl-F key and the Find On Tape option on the Tape Menu. 
Calculator on Top 

Ctrl-G key and the Calculator on Top option on the Properties Menu. 
Hide Main Window 

Ctrl-H  key and the Hide Main Window option on the Properties Menu. 
Insert into Previous Program 

Ctrl-I key and the Insert into Prev. Prog. option on the Edit Menu. 
View RPN Stack 

Ctrl-K key and the View RPN Stack option on the Edit Menu.  This option is 
available only when using RPN mode.  

Clear Tape 
Ctrl-L key and the Clear Tape option on the Tape Menu. 

Publish Tape 
Ctrl-N  key and the Publish Tape option on the Tape Menu. 

Open Saved Tape 
Ctrl-O  key and the Open Saved option on the Tape Menu. 

Print Tape 
Ctrl-P  key and the Print Tape option on the Tape Menu. 

Show in Tray 
Ctrl-S key and the Show in Tray option on the Properties Menu. 

Stay on Top 
Ctrl-T key and the Stay on Top option on the Properties Menu. 

Paste Clipboard to Readout 
Ctrl-V key and the Paste option on the Edit Menu. 

Write Tape to File 
Ctrl-W key and the Write to File option on the Tape Menu. 

Exit CDML Advanced Calculator 
Ctrl-X key and the Exit option on the File Menu. 

Tape to Scratch Pad 
Ctrl-Z key and the Tape to Scratch Pad option on the Tape Menu. 

On-Line Help 
F1 key and the CDML Calculator Help option on the Help Menu. 

About CDML Advanced Calculator 
F2 key and the About CDML Calculator option on the Help Menu. 

Find Next 
F3 key and the Find Next option on the Tape Menu. 

Calculator and Tape Properties 
F4 key and the Properties option on the Properties Menu. 

Allow Tape Editing 
F5 key and the Allow Tape Editing option on the Tape Menu. 
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Time/Date Calculations 
F6 key and the Time/Date Calculations option on the File Menu 

Calendar 
F7 key and the Calendar option on the File Menu. 

Currency Conversions 
F8 key and the Currency Conversions option on the File Menu 

Numeric Base Conversions 
F9 key and the Base Conversions option on the File Menu 

Scratch Pad 
F12 key and the Scratch Pad option on the File Menu. 

 
 

Toolbar Setup 
 
Use this screen to set the function a 
Toolbar button will perform.  When you 
open this screen, the screen caption will 
remind you which number button you are 
setting up. 
 
Type of Function (command) List 

There are five types of functions: 
Financial, Mode, Other, Scientific 
and Tape.  Select the type of func-
tion you wish this button to per form. 

Available Functions List 
After you select the type of function, you will see a list of all avaiable functions of 
that type. Select the function you want this button to perform. 

OK Button 
Save changes and exit. 

Cancel Button 
Exit without saving changes. 

 
 

Set Properties 
 

Use this screen to set up the properties of CDML Advanced Calculator.  You should 
configure the calculator to those settings, which you find most convenient.   
 
When you open the Properties window, your current settings will be displayed.  At 
this point you can modify any of the available settings.   If you wish to exit without 
saving your changes, then push the "Cancel"  button (or hit the Esc key).  If you wish 
to make your changes temporary, then push the "OK" button.   
 
If you wish to save your changes as "default settings", then push the "Save"  button 
or hit the Enter key. 
 
Tape Properties 

For the tape you can set the Font, Font Size, Font Color, Font Bold, Font Italic, 
Tape Size and Tape Hidden/Visible properties.  For the calculator itself, you can 
save the position of the Calculator as well as the position of the Stay-On-Top 
window (if the Stay-On-Top window is open).   
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Start Minimized 
If you check the "Start Min" 
box, then the next time you 
start CDML Advanced Cal-
culator, the calculator will 
not be visible until you click 
on the tray icon. 
NOTE:   DO NOT SET 
THE RUN MINIMIZED IN 
THE WINDOWS SHORT 
CUT PROPERTIES! 

Start On Top 
If you check the "Start On 
Top" box, then the next 
time you start CDML Ad-
vanced Calculator, only the 
Stay-On-Top window will 
be visible. 
NOTE:  Start Minimized 
and Start On Top boxes 
can not be checked at the 
same time. 

Calc. On Top 
If this option is checked, then the main calculator screen will remain Topmost. 

Carry Result 
If you check the "Carry Result" box, then the result of your calculation will re-
main in the Readout.  If you clear this box, the Readout will be reset to 0 after 
the calculation is completed.  (To complete the calculation you must push the 
"=" button.) 

Financial Mode 
If you check the "Fin Mode" box, then the result of your calculation will always 
be displayed in a currency format (i.e. 5 will be 5.00, 3.2 will be 3.20 and 4.006 
will be 4.01). The number of visible decimal places depends directly on your set-
ting for Decimal Places (found on this screen).  This option may also be set from 
the Modes menu. 

Save Memory 
If you check the "Save Mem" box, then the calculator memory will be saved as 
you exit the calculator.  The next time you start CDML Advanced Calculator, the 
memory will be set to what it was the last time you used the calculator. 

Adding Machine 
If you check the "Adding Machine" box, then the calculator will work like an old 
fashioned adding machine, where you first enter an operand (number) and then 
the operator.  The first operator is always a plus (+) in this mode, regardless of 
what you press.  After you enter the last number in your series, pressing the 
equal sign (=) is the same as pressing a plus followed by an equal.  If addition is  

       not your desired operation, then press the operator that you need followed by 
the equal sign.  This option may be set from the Modes menu. 

Show % 
If you check the "Show %" box, then the calculator will print the actual percent-
age value to tape (as well as the derived value in the Readout).  This option may 
also be set from the Modes menu.  

Format Numbers 
If this option is checked, then the numbers displayed on tape will be formatted in 
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accordance with your geographic format parameters.  (i.e.  1000.00 will become 
1,000.00, 300000.555 will become 300,000.555, and so forth.) 

Percentage for Number 
If this option is checked, then the percentages will be calculated for the previous 
value.  Otherwise the percentages will be calculated as the number you entered 
divided by 100.  For example: expression 200+200-20% will equal to 320 if this 
option is checked or 399.80 if this option is not checked. 

RPN Mode 
This mode allows you to enter numbers and do your calculations in Reverse 
Polish Notation.  When the RPN mode is checked, you must first enter your 
numbers and then enter the operators. 

Auto-Decimal Mode 
By special request from our users in the accounting profession.  If Auto-Decimal 
Mode is checked, when entering a series of numbers, there is no need to enter 
the decimals.  The calculator will format your input based on the number of deci-
mal places you selected. 

Hide Toolbar 
If you have very limited screen real estate and do not need the Toolbar, check-
ing this box will hide it. 

Decimal Places 
You can use this option to set the number of decimal places (2 to 15) you wish 
to see when you are using Financial Calculator Mode. 

Exit Button Minimizes 
If this option is checked, clicking the Exit Button will minimize the calculator.  To 
exit the calculator, right-click on the Tray Icon and select Exit or choose Exit 
from the File Menu. 

Numeric Input Screen Hide "Clear" 
If this option is checked, then when you clear your calculation (the "C" key or 
button) the word "Clear" will not appear on the tape.  This is useful to those who 
pass their tapes to other applications.  

Calendar Starting and Ending Years 
Here you can set a range of years you wish to see in the calendar.  You can set 
any range for 100 to 9999. 
Rule 1:  Current year must be included in your range. 
Rule 2:  Starting Year must be earlier than the Ending Year. 
Hint:  The bigger is your range - the longer it will take the calendar to appear. 

Publish To 
When you click this button, you'll be prompted to enter the default File Type (3 
letter extension) for the program you wish to publish the tape to (i.e. TXT, DOC, 
XLS).  Then you will be asked to select the actual program (i.e. Excel.exe, Note-
pad.exe) to publish to. 

 

Numeric Input Screen  
 
 
 
 
 
 
 
 

Use this screen to enter numbers for those calculations, which require additional in-
put (other than the main calculator screen).  Here your input is limited to numbers (0 
to 9) and the decimal separator 
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CDML Advanced Calculator Menus 

 
• File Menu 

 
• Edit Menu 

 
• Tape Menu 

 
• Operators Menu 

 
• Modes Menu 

 
• Scientific Menu 

 
• Financial Menu 

 
• Properties Menu 

 
• Help Menu 
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File Menu 
 

Scratch Pad 
Displays a new instance of the small text 
editor. 

Show Calendar 
Displays the calendar. 

Expression Evaluator  
Same as hitting the ( button or Ctrl-E.  Use 
this to launch the Expression Evaluator. 

Time/Date Calculations 
Same as hitting F6.  Use this option to cal-
culate differences between various times 
and dates. 

Currency Conversions  
Same as hitting F8.  Use this option to con-
vert between various currencies.  You can 
sign up for daily exchange rates updates. 

Base Conversions 
Same as hitting F9.  Use this option to convert numeric values between binary, 
octal, decimal and hexadecimal systems. 

Construction Calculator (ft/in) 
Same as hitting Ctrl-B.  Use this option to make calculations in feet and inches. 

Start/Stop Project Timer 
Same as pushing the Stop Watch button.  Use this option to start or stop the 
Project Timer. 

Backup Data 
Use this feature to backup your Daily Notes, Alarms and Formulas. 

Restore Data 
Use this feature to restore previously backed-up data. 

Exit 
Exit the CDML Advanced Calculator. 

 
Edit Menu 

 
Copy 
       Save the contents of the readout to the clipboard.  If you have selected 

(highlighted) text on the Tape, then that text will be 
saved to the clipboard instead of the contents of 
the readout. 

Paste 
       Save the contents (numeric only) of the clipboard 

to the readout.  If you are in Tape Editing Mode, 
then you are able to paste any text to the tape. 

Insert into Previous Program 
       Since the CDML Advanced Calculator is often used to calculate results which 

will be later entered into a different program, this option was added to automate 
this task.  By using this option, you can insert the result of your calculations di-
rectly to the program which was used immediately prior to using the CDML Ad-
vanced Calculator.  This is equivalent to Copying the Result, Minimizing the 
CDML Advanced Calculator, and Pasting to the other program at the cursor 
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       position.  If you started the CDML Advanced Calculator with the "/nic" command 
line switch then this option will also exit the program. 

View RPN Stack 
       Use this option when you are using RPN mode and wish to see the contents of 

your stack.  The stack will be displayed in a separate floating window. 
Set Billing Rate 
       Use this option to set the default Hourly Billing Rate used for calculations in the 

Project Timer and the Billing Function. 
 

       Tape Menu 
 
Format Numbers 
       If this option is checked, then the numbers displayed on tape will be formatted in 

the following manner: 1000.00 will show as 1,000.00, 300000.555 will show as 
300,000.555, and so forth. 

Print 
       Send the contents of the tape to the default printer.  

You can select which printer to use from the File 
Menu. 

Publish 
       Send the contents of the tape to Windows Notepad 

(or your default Text Editor) for editing.  If you config-
ured the Publish To settings, then the tape will be 
sent to the program you specified. 

To Scratch Pad 
       Send the contents of the tape Scratch Pad.  This is 

useful because the tape text is padded with spaces 
on the left so that it will look right aligned when using 
fixed-width fonts (i.e. Courier New). 

Clear 
       Clear the contents of the tape. 
Allow Editing 
       Allows you to freely write on the tape.  Exit this mode to resume normal calcula-

tor functions. 
Open Saved 
       Use this option to insert a previously saved tape (or any other text file) into the 

tape. 
Write to File 
       Save the contents of the tape to a text file. If the file you selected already exists, 

you will be given a choice to append to that file or to replace it. 
Annotate / Select All Text 
       Enter notations on the tape.  Allows you to add your notation to the bottom of 

the tape.  If your cursor is located on the tape, then this function will select all 
text on the tape.  

Find 
Search tape for any word, number or expression.  The found text will be se-
lected. 

Find Next 
Repeat last search. 
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Operators Menu 
 
Add  

Same as hitting the + button. 
Subtract 

Same as hitting the - button. 
Multiply  

Same as hitting the * button. 
Divide  

Same as hitting the / button. 
Percent  

Same as hitting the % button. 
Square Root  

Same as hitting the x½ button. 
Square  

Same as hitting the x2 button. 
Change Sign 

Changes the sign of the value in the Readout between 
positive and egative. 

Clear  
Same as hitting the C button. Use this to clear the last 
calculation and reset to 0. 

Clear Entry  
Same as hitting the CE button.  Use this to clear the last 
entry. 

 
MEMORY FUNCTIONS 
Store 

Ctrl-M key combination and the MS button on the CDML Calculator Stores the 
currently displayed number in memory. 

Recall 
Ctrl-R key combination and the MR button on the CDML 
Calculator Recalls and displays the number from mem-
ory. 

Add to 
M (capital 'M') key and the M+ button on the CDML Ad-
vanced Calcula tor Adds the currently displayed number to the number stored in 
memory and stores the new value.  
NOTE:  The new value is not displayed until you recall it. 

Subtract from 
m (small 'm') key and the M- button on the CDML Advanced Calculator Sub-
tracts the currently displayed number from the number stored in a memory  
and stores the new value.  
NOTE:  The new value is not displayed until you recall it. 

Clear 
The MC button on the CDML Advanced Calculator Clears the memory and hides 
the check mark. 
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     Modes Menu 
Financial 
       This will display the result of your calcula-

tions in a currency format (i.e. 5 will be 5.00, 
3.2 will be 3.20 and 4.006 will be 4.01).  The 
number of visible decimal places depends 
directly on your setting for the number of 
decimal places you wish to see. 

Auto-Decimal 
       By special request from our users in the ac-

counting profession.  If Auto-Decimal Mode 
is checked, when entering a series of num-
bers, you don't need to enter the decimals.  
The calculator will format your input based on 
the number of decimal places you selected. 

Adding Machine 
       The calculator will work like an old-fashioned 

adding machine, where you first enter an op-
erand (number) and then the operator.  The 
first operator is always a plus (+) in this 
mode, regardless of what you press.  After 
you enter the last number in your series, 
pressing the equal sign (=) is the same as 
pressing a plus followed by an equal.  If addi-
tion is not your desired operation, then press 
the operator that you need and then the 
equal sign. 

RPN 
       This mode allows you to enter numbers and 

do your calculations in the Reverse Polish 
Notation.  When the RPN mode is checked, 
you must first enter your numbers and then enter the operators. 

       NOTE:  RPN and Adding Machine modes Can't be on at the same time. 
Show Percentages 
       The calculator will print the actual percentage value to tape (as well as the de-

rived value in the Readout). 
% for Number 
       If this option is checked, then the percentages will be calculated for the previous 

value.  Otherwise the percentages will be calculated as the number you entered 
divided by 100.  For example: expression 200+200-20% will equal to 320 if this 
option is checked or 399.80 if this option is not checked. 

Magic Number (mathematical constant) 
       If this option is checked then you can perform multiple operations for a single 

operand.  The first operand entered will become the Magic Number.  All follow-
ing operations will be performed for the Magic Number.  Example:   
Magic Number Off                     Magic Number On 

       5+2=7                                        5+2=7 
       +8 [7+8]=15                               +8 [5+8]=13 
       +9 [15+9] =24                            +9 [5+9] =14 
Carry Result 

If this option is checked, then the result of your calculation will remain in the  
Readout.  If it's not checked, the Readout will be reset to 0 after the calculation 
is completed.  (To complete the calculation push the = button.) 
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Repeat Subtraction 
If this option is checked, then you can repetitively press Minus ("-") for subtrac-
tion. 
NOTE: If this mode is turned on, you will need to use the Change Sign option on 
the Operators Menu or the "+/-" button on the calculator to enter negative num-
bers. 

Intra-System Conversions 
There are seven Intra-System conversion modes: Metric, Computer and English 
Weight, Square, Cubic, Length and Capacity.  These are useful to determine 
relations between units of measure in the same system (i.e. 1 bite =  
0.0001220703125 kilobytes).  

Imperial English Measures 
If this option is checked, then the Area and Volume conversions will use Impe-
rial gallons and pints. 

Troy English Measures 
If this option is checked, then the Mass and Distance conversions will use Troy 
pounds and ounces. 

No Conversions 
Reset the Calculator to standard mode. 
NOTE: The following modes may also be changed by the Next Mode and Previ-
ous Mode buttons on the calculator. 

Metric to English 
Set mode to Metric to English weight and distance conversions or perform same 
conversions. 

English to Metric 
Set mode to English to Metric weight and distance conversions or perform same 
conversions. 

Area/Volume Metric to English 
Set mode to English to Metric area and volume conversions or perform same 
conversions. 

Area/Volume English to Metric 
Set mode to English to Metric area and volume conversions or perform same 
conversions. 

Temperature 
Set mode to temperature conversions or perform same conversions. 

Time-Week 
Set mode to Time conversions with the Week as a primary unit or perform same 
conversions. 

Time-Day 
Set mode to Time conversions with the Day as a primary unit or perform same 
conversions. 

Time-Hour 
Set mode to Time conversions with the Hour as a primary unit or perform same 
conversions. 

Time-Minute 
Set mode to Time conversions with the Minute as a primary unit or perform 
same conversions. 

English/Metric Other 
Set mode to Other English/Metric conversions or perform same conversions. 

 

NOTE:  For more information, see "Using Conversion Functions". 
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Scientific Menu 
 
Sine 
Cosine 
Tangent 
Arctangent 
Natural Logarithm 
Exponent (base of natural logarithm) 
Secant 
Cosecant 
Cotangent 
Logarithm to Base N (you will be prompted to 

enter the value for the base) 
 
Inverse Sine 
Inverse Cosine 
Inverse Secant 
Inverse Cosecant 
Inverse Cotangent 
 
Hyperbolic Sine 
Hyperbolic Cosine 
Hyperbolic Tangent 
Hyperbolic Secant 
Hyperbolic Cosecant 
Hyperbolic Cotangent 
 
Inverse Hyperbolic Sine 
Inverse Hyperbolic Cosine 
Inverse Hyperbolic Tangent 
Inverse Hyperbolic Secant 
Inverse Hyperbolic Cosecant 
Inverse Hyperbolic Cotangent 
 
NOTE: The values for these calculations may be entered in Degrees or Radians. 
 
Degree 

The standard method of entering values. 
Radian 

1 Radian is equal to 180/pi degrees. 
 

Additional Scientific Features. 
Reciprocal 

Takes an immediate reciprocal (1/x) of  the value 
in the Readout. 

Fractions 
Convert decimal values to fractions. 

Pi Value 
Enters the pi value to the Readout. 
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e constant Value 
Enters the e value to the Readout. 

Golden Cut Value 
Enters the golden cut value to the Readout. 

 
 
 
 

Financial Menu 
 

Interest Payment 
Returns the interest payment for a given period of an annuity based on periodic, 
fixed payments and a fixed interest rate. 

Interest Rate per Period 
Returns the interest rate per period 
for an annuity. 

Interest for X Days 
Returns the interest (straight or 
compound) for a given period (in 
days) of an annuity based on a fixed 
interest rate. 

Internal Rate of Return 
Returns the internal rate of return 
for a series of periodic cash flows 
(payments and receipts). 

Modified Internal Rate of Return 
Returns the modified internal rate of 
return for a series of periodic cash 
flows (payments and receipts). 

Number of Payments to Pay Off Loan 
Returns the number of periods for 
an annuity based on periodic, fixed 
payments and a fixed interest rate. 

Net Present Value of Investment 
Returns the net present value of an investment based on a series of periodic 
cash flows (payments and receipts) and a discount rate. 

Annuity Payments 
Returns the payment for an annuity based on periodic, fixed payments and a 
fixed interest rate. 

Annuity Principal Payment 
Returns the principal payment for a given period of an annuity based on peri-
odic, fixed payments and a fixed interest rate. 

Present Value of an Annuity 
Returns the present value of an annuity based on periodic, fixed payments to be 
paid in the future and a fixed interest rate. 

Future Value of an Annuity 
Returns the future value of an annuity based on periodic, fixed payments and a 
fixed interest rate. 

Straight Line Depreciation 
Returns the straight line depreciation of an asset for a single period. 

Sum-of-Years' Digits Depreciation 
Returns the sum-of-years' digits depreciation of an asset for a specified period. 
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Double Declining Balance Depreciation 
Returns the depreciation of an asset for a specific time period using the double-
declining balance method. 

NOTE:  For more information see the Explanation of Financial Functions. 
 

Properties Menu 
 
Properties 

View or modify the settings for CDML Advanced Calculator 
Show in Tray 

Show CDML Advanced Calculator in the System 
Tray (bottom-right corner).  When the calculator 
icon is in the tray, you only need to click on it and 
CDML Advanced Calculator will come     to the 
front of all your open windows.  If you right-click 
on it, you will see a menu of available choices.  
See Easy Access. 

Stay On Top 
When this item is selected, CDML Advanced Cal-
culator will disappear and instead you will see a 
small, floating, yellow label "Show CDML Ad-
vanced Calculator".  When you double-click this 
label, the Calculator will appear and the label will 
change to "Hide CDML Calculator".  To hide the 
calcula          tor, just double-click the label again.  
See Easy Access. 

Calculator On Top 
If this option is checked, then the main calculator 
screen will remain Topmost. 

Hide Main Window 
Allows you to hide the CDML Advanced Calculator window, but it leaves the 
Tray Icon or the On Top window (depending on the mode) in place. 

Number Tape Items 
If this option is checked, line item numbers will appear to the right of the value 
on tape.  This does not apply to RPN mode.  Line items will reset af ter you 
press Clear or Equal.  

Don't Hide Evaluators 
If this option is checked, neither the Expression Evaluator nor the Construction 
Calculator will disappear after you click the OK button.  This is useful if you need 
to see your original expression. 

Exit Button Minimizes 
If this option is checked, clicking the Exit Button will minimize the calculator.   

       To exit the calculator, right-click on the Tray Icon and select Exit or choose Exit 
from the File Menu. 

Repeat Entry 
Allows you to perform multiple operations with the same operand.  For exam-
ple, to add 5 seven times you can enter 5 and then hit the + six times and hit =.  
Without this mode, you must hit the 5 followed by a + six times and then hit 5 
followed by =. 

Swap + and Enter 
Allows you to swap the + and the Enter keys on the number pad.  This is for us-
ers who are most comfortable with a 10 key where you use the pinky to add. 
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Copy Formatted 
Allows you to copy the contents of the Readout in formatted form. 

Select Printer 
Allows you to select which printer you wish to print your tape to (useful if you 
have multiple printers or want to fax the tape). 

Set Alarms 
Use this option to set your Reminder Alarms. 

Alarms Enabled 
Check this option to enable Reminder Alarms. 

Hide / Show Number Keys 
If you have limited screen real estate and don't use the On-Screen Number Pad 
(the bottom portion of the calculator), then you can hide it.  See Easy Access. 

Hide / Show Tape 
You can hide the Tape if you have limited screen real estate and/or don't use it.  
See Easy Access. 

Hide / Show Toolbar 
You can hide the Toolbar if you have limited screen real estate and/or don't use 
it.  See Easy Access. 

NOTE:  Show in Tray and Stay on Top can not be used at the same time. 
 
 

Help Menu 
 
CDML Calculator Help 

Opens this help file. 
Search Help 

Allows you to immediately start searching the 
help file. 

Technical Support 
Instructions for obtaining technical support. 

Registration 
Access to various ways to register the CDML 
Advanced Calculator. 

Registration Screen 
Opens the Registration Screen. 

Register On-Line 
Register the CDML Advanced Calculator on-
line.  You can use your credit card from any-
where in the world.  The Registration Screen will 
automatically be opened for your convenience. 

Registration Form 
Open the Registration Form.  To complete the 
form, press the Print button to print the form, fill it 
out and submit it to CDML Computer Services, 
Ltd.  The Registration Screen will automatically 
be opened for your convenience. 

CDML On The Web 
Easy access to CDML resources on the Internet. 

CDML Web Site 
Link to CDML Computer Services, Ltd. Home on 
the Internet. 
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Calculator Web Site 
Link to CDML Advanced Calculator home on the Internet. 

Email Technical Support  
Email to CDML Technical Support. All question will be responded in 96 hours.  

Email Sales 
Email massage to our sales person. 

Join CDML Mailing List 
Link to CDML Mailing List.  By joining the CDML Mailing List, you will be notified 
of the latest developments at CDML.  You will also be eligible for special offers 
and promotions. 

Email CDML 
Send an email message to CDML. 

About CDML Calculator 
Shows the About dialog.  Here you can see the program version, contact infor-
mation or jump to the CDML Computer Services, Ltd. Web site. 
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Advanced Calculator Functions 
 
 

• Financial Functions 
 

• Conversion Functions 
 

• Currency Conversions 
 

• Numeric Base Conversions 
 

• Intra-System Unit Conversions 
 

• Expression Evaluator 
 

• Construction (Foot/Inch) Calculator 
 

• Additional Valid Keys in Expression Evaluator and 
Construction (Foot/Inch) Calculator 
 

• Formula Editor 
 

• Time and Date Calculations 
 

• Time Entry 
 

• Calendar 
 

• Date Notes/RPN Stack/Scratch Pad 
 

• Reminder Alarms  
 

• Sending Keystokes with Alarms 
 

• Project Timer 
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Financial Functions 
 

Financial functions are used for various financial calculations.  To use these func-
tions you must answer the questions asked and the result will appear on tape to-
gether with your answers. 
 
Interest Calculator 

Returns the interest payment for a given period of an annuity based on periodic, 
fixed payments and a fixed interest rate.  For all arguments, cash paid out (such 
as deposits to savings) is represented by negative numbers; cash received 
(such as dividend checks) is represented by positive numbers. 

Interest Rate per Period 
Returns the interest rate per period for an annuity.  For all arguments, cash paid 
out (such as deposits to savings) is represented by negative numbers; cash re-
ceived (such as dividend checks) is represented by positive numbers. 

Interest for X Days 
Returns the interest (straight or compound) for a given period (in days) of an 
annuity based on a fixed interest rate.  For all arguments, cash paid out (such 
as deposits to savings) is represented by negative numbers; cash received 
(such as dividend checks) is represented by positive numbers. 

Internal Rate of Return 
Returns the internal rate of return for a series of periodic cash flows payments 
and receipts).  

Modified Internal Rate of Return 
Returns the modified internal rate of return for a series of periodic cash flows 
(payments and receipts). 

Number of Payments to Pay Off Loan 
Returns the number of periods for an annuity based on periodic, fixed payments 
and a fixed interest rate.  For all arguments, cash paid out (such as deposits to 
savings) is represented by negative numbers; cash received (such as dividend 
checks) is represented by positive numbers. 

Net Present Value of Investment 
Returns the net present value of an investment based on a series of periodic 
cash flows (payments and receipts) and a discount rate. 

Annuity Payments 
Returns the payment for an annuity based on periodic, fixed payments and a 
fixed interest rate.  For all arguments, cash paid out (such as deposits to sav-
ings) is represented by negative numbers; cash received (such as dividend 
checks) is represented by positive numbers. 

Annuity Principal Payment 
Returns the principal payment for a given period of an annuity based on peri-
odic, fixed payments and a fixed interest rate.  If desired, you will receive a full 
payment breakdown based on principal and interest for each period.  For all ar-
guments, cash paid out (such as deposits to savings) is represented by negative 
numbers; cash received (such as dividend checks) is represented by positive 
numbers. 

Present Value of an Annuity 
Returns the present value of an annuity based on periodic, fixed payments to be 
paid in the future and a fixed interest rate.  For all arguments, cash paid out 
(such as deposits to savings) is represented by negative numbers; cash re-
ceived (such as dividend checks) is represented by positive numbers. 

Future Value of an Annuity 
Returns the future value of an annuity based on periodic, fixed payments and a 
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fixed interest rate.  For all arguments, cash paid out (such as deposits to sav-
ings) is represented by negative numbers; cash received (such as dividend 
checks) is represented by positive numbers. 

Straight Line Depreciation 
Returns the straight line depreciation of an asset for a single period.  The depre-
ciation period must be expressed in the same unit as the life of the asset.  For 
example, to see the depreciation in months, you must declare the life of the as-
set in number of months.  All arguments must be positive numbers. 

Sum-of-Years' Digits Depreciation 
Returns the sum-of-years' digits depreciation of an asset for a specified period.  
The life and period arguments must be expressed in the same units.  For exam-
ple, if life is given in months, period must also be given in months.  All argu-
ments must be positive numbers. 

Double Declining Balance Depreciation 
Returns the depreciation of an asset for a specific time period using the double-
declining balance method.  The life and period arguments must be expressed in 
the same units.  For example, if life is given in months, period must also be 
given in months.  All arguments must be positive numbers. 

 
Using Conversion Functions 

 
 

To use the Conversion Functions, click the Mode button 
(original mode is Calculator) until you reach the desired 
conversion mode. Once the desired conversion mode is 
displayed, enter the number you wish to convert and click 
on the appropriate conversion button (see list below). The 
result will be immediately displayed. You can also obtain 
the same result by entering the number to convert and 
choosing the corresponding item on the Modes Menu. 
 

Metric to English 
 

              Distance                             Weight 
 

Centimeters to Inches                      Grams to Ounces 
Meters to Feet                                  Kilograms to Pounds 
Meters to Yards                                Tonnes to Long Tonnes (default)   
Kilometers to Miles                           Tonnes to Short Tonnes  
 

English to Metrics                                          
 
              Distance                              Weight  
 

Inches to Centimeters                      Ounces to Grams  
Feet to Meters                                  Pounds to Kilograms           
Yards to Meters                                Long Tons to Tonnes(default)  
Miles to Kilometers                           Short Tons to Tonnes 
 

Area and Volume Metric to English                            
. 

              Area                                   Volume 
 

Centimeters to Inches (square)        Meters to Feet (cubic)  
Meters to Feet (square)                    Meters to Yards (cubic) 
Meters to Yards (square)                  Liters to Pints 
Kilometers to Miles (square)             Liters to Gallons 
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Area  and Volume English to Metric                           
 

              Area                                    Volume 
 

Inches to Centimeters (square)        Feet to Meters (cubic) 
Feet to Meters (square)                    Yards to Meters (cubic) 
Yards to Meters (square)                  Pints to Liters 
Miles to Kilometers (square)             Gallons to Liters 
 

Temperature                                     
 

              Area                                    Volume 
. 

Centigrade to Fahrenheit                  Fahrenheit to Centigrade 
Centigrade to Kelvin                         Fahrenheit to Kelvin 
Kelvin to Centigrade                         Kelvin to Fahrenheit  
 

Time Conversions using Weeks                                 
 

              From Weeks                       To Weeks 
 

Week(s) to Day(s)                            Day(s) to Week(s) 
Week(s) to Hour(s)                           Hour(s) to Week(s) 
Week(s) to Minute(s)                        Minute(s) to Week(s) 
Week(s) to Second(s)                       Second(s) to Week(s)  
 

Time Conversions using Days                                    
 

              From Days                          To Days  
Hour(s) to Week(s)                           Week(s) to Day(s) 
Hour(s) to Day(s)                              Hour(s) to Day(s) 
Hour(s) to Minute(s)                          Minute(s) to Day(s) 
Hour(s) to Second(s)                        Second(s) to Day(s)  
 

Time Conversions  using Hours                                 
 

              From Hours                        To Hours  
Hour(s) to Week(s)                           Week(s) to Minute(s) 
Hour(s) to Day(s)                              Day(s) to Hour(s) 
Hour(s) to Minute(s)                          Hour(s) to Minute(s) 
Hour(s) to Second(s)                        Second(s) to Minute(s)  
 

Time Conversions using Minutes                               
 

              From Minutes                     To Minutes  
 

Minute(s) to Week(s)                        Week(s) to Minute(s) 
Minute(s) to Day(s)                           Day(s) to Minute(s) 
Minute(s) to Hour(s)                          Hour(s) to Minute(s) 
Minute(s) to Second(s)                     Second(s) to Minute(s)  
 

Other English/Metric Conversions                                           
 

Miles/Gallon to Kilometers/Liter        Kilometers/Liter to Miles/Gallon 
MPG to Liters/100 Kilometers           Liter/100 Kilometers to MPG 
PSI to Kilograms/sqr. Centimeter     Kilograms/sqr. Centimeter to PSI 
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Currency Conversion 
 

Use this screen to calculate the Exchange Rate between two currencies.  If you have 
a value displayed in the Readout, that value will be passed to this screen as the 
amount of the From currency (otherwise amount will be set to 1). 
 
HINT:  You can see formatted numbers in the Tooltips of each value. 
 
When you open this screen, the From and To currencies will be set to those you 
used last. 
 
From Currency 

A drop-down list of available currencies.  Each currency is represented as the 3 
letter abbreviation followed by the full name. 

Direction Button  
Used to change the direction of calculation between the From and the To val-
ues. 

To Currency 
A drop-down list of available currencies.  Each currency is represented as the 3 
letter abbreviation followed by the full name. 

= (Equal Sign) 
This is the result of 
your conversion be-
tween the From and 
the To Currencies.  

D/L Rates 
Click this button to 
receive the latest 
Currency Exchange 
Rates file from the 
Internet.  Follow 
additional in-
structions in the 
message window. 
NOTE:  You must 
subscribe to this 
service separately. 

Open File Button 
Once you extracted 
the new rates, you 
need to open the 
new file and the exchange rates (plus the To and From Currencies) will be re-
freshed. 

Dec. Pl. 
Here you can set the number of decimal places to round your exchange rate 
calculation to.  You can choose to round from 2 to 9 decimal places or "No" to 
disable rounding. 
NOTE:  Rounding is performed on the actual rates as well as the result, so you 
might see some minor inconsistencies. 

OK Button 
Click this button to enter the result value into the Calculator Readout for further 
calculations. 
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Cancel Button 
Close this screen. 

Make Topmost Window (Up Arrow button) 
Click this button if you want this screen to "float on top" of all other windows. 

Show D/L Help 
If this option is checked, you will see a message window with instructions after 
you click the D/L Rates button. 

 
Numeric Base Conversions 

 
Use this screen to convert numbers between Binary (base 2), Octal (base 8), Deci-
mal (base 10), and Hexadecimal (base16) representations.  If you have a value dis-
played in the Readout, that value will be passed to this screen. 
 
Base Option 

There are four Base Option buttons on this screen.  Click on the button corre-
sponding to the base you wish to use.  (Decimal is default.) 

Entry Box 
This is where you enter the value you wish to use.  Only numbers (and letters) 
valid for the chosen base will 
work. 

Cancel Button 
Close this screen. 

OK Button 
Pass the Decimal equivalent of 
the value you entered back to 
the Readout and close the Base 
Conversions screen. 

Make Topmost Window (Up Arrow button) 
Click this button if you want this screen to "float on top" of all other windows. 

 
Intra-System Unit Conversions 

 
Use this screen to calculate the differ-
ence between two units of measure in the 
same system.  If you have a value dis-
played in the Readout, that value will be 
passed to this screen as the amount of 
the From unit (otherwise amount will be 
set to 1). 
 
HINT:  You can see formatted numbers in the Tooltips of each value. 
When you open this screen, the From and To units will be set to those you used last. 
 
From Unit 

A drop-down list of available units. 
Direction Button  

Used to change the direction of calculation between the 
From and the To values. 

To Unit 
A drop-down list of available units. 

OK Button 
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Click this button to enter the result value into the Calculator Readout for further 
calculations. 

Cancel Button 
Close this screen. 

Make Topmost Window (Up Arrow button) 
Click this button if you want this screen to "float on top" of all other windows. 

 
There are 7 Intra-System Conversion modes.  They are as follows: 

 
Metric Units 

exa, peta, tera, giga, mega, kilo, hecto, deka, deci, centi, milli, micro, nano, pico, 
femto, atto. 

English Weights 
Grain, Dram, Ounce, Pound, Stone, Hundred weight, Long hundred weight, 
Long ton, Short ton. 

English Square (include English acres to Metric hectares conversion) 
Sq. Inch, Sq. Foot, Sq. Yard, Sq. Rod, Acre, Sq. Mile, Hectare (metric). 

English Cubic 
Cu. Inch, Cu. Foot, Cord foot, Cu. Yard, Cord, US gallon, British gallon, US 
bushel, British bushel. 

English Length 
Mil, Inch, Link, Foot, Yard, Fathom, Rod, Chain, Furlong, Cable's length, Mile, 
Nautical mile, League 

English Capacity 
Fluid ounce, Gill,  Pint, Quart, Gallon, Peck, Bushel 

Computer Units 
bit, nibble, byte, kilobit, kilobyte, megabit, megabyte, gigabyte, terabyte, pe-
tabyte,  exabyte, zettabyte,  yottabyte. 

 
 

Using the Expression Evaluator  
 

The Scientific Expression Evaluator is used to obtain results from a complex or sim-
ple mathematical expression.  It follows the operator hierarchy and algebraic gram-
mar rules.  For example, in a standard calculator 2+2*3 would equal 12, but in an 
algebraic calculator that same expression would equal 8.  This is because in a stan-
dard calculator the expression is evaluated from left to right, but in an algebraic cal-
culator, calculations follow the rules of algebra (operator hierarchy takes priority).  In 
this particular case the first action would be multiplication and then addition.  You 
must also remember that bracketed expressions and powers are calculated before 
anything else. 
 
Operator Hierarchy: 
1.  Brackets [()] 
2.  Power [^] 
3.  Multiplication [*], Division [/], Remainder [\] 
4.  Addition [+] and Subtraction [-] 
 
You can use all numbers [0 to 9]  on the keyboard, as well as Other Valid Keys to 
enter your expressions.  You can also use up to three Variables (X,Y & Z).   
 
Enter your expression into the main Expression Readout box.  (This is the box lo-
cated to the left of the OK button.)  You can either type your expression or paste it 
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from the Windows Clipboard. 
 
To use the variables, enter corresponding values in to the three boxes.  When you 
build your expression, enter the variables instead of the numbers.  Don't forget to 
enter the correct  operators.  For example, if X=5 and Y=5 then the expression XY 
will be calculated as 5*5.  If you wish to reset the variable values, then push the 
Clear Variables button.  Along 
the same lines, the expres-
sion 3X/2X will be calculated 
as (3*5)/(2*5) (resulting in 
1.5), NOT as 3*5/2*5 
(resulting in 37.5). 
 
The Expression can be edited 
as regular text (using arrow 
keys to move around).  Once you have entered the expression, the CDML Advanced 
Calculator is going to remember it, so that when you call up the Expression Evalua-
tor again your original expression will still be there. 
 
Once you finished entering the expression, press the Enter key or click the OK but-
ton and your expression will be added to the tape together with the result.  If you 
wish to abort, click the Cancel button or press the Esc key. 
 
NOTE:  If the expression had to be interpreted by the Expression Evaluator and you 
checked the Confirm Expression box, you will receive a message with the interpreted 
expression.  Hence, you will be able to make a choice of either accepting the expres-
sion or editing it.  Click on the button corresponding to your choice: 
 
·          Yes        Accept the expression 
·             No         Edit the interpreted expression 
·             Cancel  Edit the original expression 
 
Make Topmost Window (Up Arrow button) 

Click this button if you want the Expression Evaluator to "float on top" of all other 
windows. 

Formula Drop-Down List 
You can select any of your saved formulas from this list and insert them into 
       the Expression Readout.  Once you do this, you can modify your constant 
and/or variable values and evaluate the expression. 

Insert Button 
After selecting the desired formula, click this button to insert it into the Expres-
sion Readout. 

Formulas Button 
Click this button to open the Formula Editor. 

 
 

Construction (Foot/Inch) Calculator 
 
Those who use the Metric system have it easy!  They don't have to put up with such 
nonsense and measuring their homes in feet and inches.  Unfortunately, we don't 
live in a perfect world.  This option was developed for those of us who need to be 
able to make calculations in the English system. 
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The Construction Calculator was developed on the basis of the Expression Evalua-
tor.  The Construction Calculator follows the same rules of algebra as the Expression 
Evaluator, but it allows you to enter values in feet and inches (i.e. 2'5" * 3'8") 
 
Expression Readout 

This is the box located to the left of the OK button.  Enter (type or paste) your 
expression here. 

Value of X, Value of Y, Value of Z 
These are the three boxes located underneath the Expression Readout.  If you 
with to use variables in your expression, you should enter the corresponding 
values for your variable here.  (See Using the Expression Evaluator for more 
information on using variables.) 

Clear Variables 
By clicking this button you will reset all variables to zero. 

Make Topmost Window (Up Arrow button) 
Click this button if you want the Construction Calculator to "float on top" of all 
other windows. 

Confirm (check box) 
If you check this box and the calculator had to interpret anything in your expres-
sion, you will receive a message with the interpreted expression.  Hence, you 
will be able to make a choice of either accepting the expression or editing it.  
Click on the button corresponding to your choice: 

          ·           Yes        Accept the expression 
             ·           No         Edit the interpreted expression 
             ·           Cancel  Edit the original expression 
Convert (check box) 

If this box is checked, your expression will appear on tape as the calculator in-
terpreted it.  Otherwise, your original expression will appear on tape. 

Result in Ft/In (check box) 
If this box is checked, the result of your expression will appear on tape in feet 
and inches.  Otherwise, the result will appear as a standard number. 

Result to Readout (check box) 
If this box is checked, the unformatted result of your calculation will appear in 
the Readout of the calculator. 

OK and Cancel buttons 
Clicking OK will process your expression, while Cancel will exit this screen. 

Formula Drop-Down List 
You can select any of your saved formulas from this list and insert them into the 
Expression Readout.  Once you do this, you can modify your constant and/or 
variable values and evaluate the expression. 

Insert Button 
After selecting the desired formula, click this button to insert it into the Expres-
sion Readout. 

Formulas Button 
Click this button to open the Formula Editor. 
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Additional Valid Keys in Expression Evaluator and  
Construction (Foot/Inch) Calculator 

 
Add 

+ key 
Subtract 

- key 
Multiply 

* key 
Divide 

/ key 
Remainder (Modulus) 

\ key (Used to divide two numbers and return only the remainder.) 
Percent  

% key 
Square 

S, s, ^ keys 
Square Root 

R, r keys 
Pi (3.141592653) 

P, p keys 
Period (Decimal Point) 

. key (you can also use a comma) 
Undo Last Key Stroke 

Back Space  ("""") key 
Copy Readout to Clipboard 

Ctrl-C key combination 
Paste Clipboard to Readout 

Ctrl-V key combination 
Variables 

X, x, Y, y, Z, z keys 
 

 

Formula Editor 
 

Using this screen, you can compile and maintain a list for formulas.  The formula 
lists are not the same for Expression Evaluator and Construction Calculator. 
 
Formula 

View/edit your formulas in this box. 
Name 

View/edit the names of your formulas in this box. 
 
List of Formulas 

List of available formulas. 
Save Button 

Save the new/modified formula.  Available only in Add/Edit mode. 
Cancel Button 

Cancel Add/Edit mode. 
Add Button 
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Click this button to add formulas to your list.  Make sure to give each formula a 
unique name. 

Edit Button 
Edit an existing formula.  First you must select (from the list) a formula you wish 
to edit and then push this button. 

Delete Button 
Select (from the list) the formula you wish to delete and push this button. 

Exit Button 
Exit this screen. 

Make Topmost Window (Up Arrow button) 
Click this button if you want this screen to "float on top" of all other windows. 
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Time/Date Calculations 
 
Use this screen to calculate the dif-
ference between two Time and/or 
Date values.  The result is returned 
in two formats: 
 
1. Standard Difference in Days, 
Hours, Minutes and Seconds. 
2. Unit Difference in each of the 
following units: year, month, day, 
hour, minute or second. 
               
When you open this screen, both 
dates will be set to today and both 
times will be set to current time. 
 
From Button and To Button 

By pressing these buttons, you will be able to manually enter the From and To 
times (quicker, but less reliable).  You may also activate these buttons by press-
ing Alt-F or Alt-T. 

Open Button 
There are four Open buttons on this screen.  Click on the button next to the 
value you wish to change (From Date or Time and To Date or Time).  Subse-
quently, you will see the Calendar or the Time Entry screen. 

Direction Button  
Used to change the direction of calculation between the From and To values. 

Put Result on Tape button 
Used to put the result in Standard Difference format on tape.  You may also acti-
vate this button by pressing the "P" on your keyboard. 

Result Values 
Click on any of the result values to enter that value into the Calculator Readout 
for further calculations.  The next time (in the same session) you open this 
screen, you will see which value was submitted. 

Add Button 
To the right of each Result Type you will notice a "+" button.  When you push 
this button, you will be able to add (or subtract by providing a negative value) 
any number of that unit.  The value you provide will be added to the From Date/
Time values and the result will be reflected in the To Date/Time values.  This 
allows you to quickly derive any future or past date. 

Cancel Button 
Close the Time/Date Calculation screen. 

Billing Calculation ($ button) 
When you click this button, you will be asked to enter an Hourly Rate.  Immedi-
ately after that, you will see the result of your calculation in the Calculator Tape 
and the Calculator Readout.  At this point, you can return to the calculator press 
one of the Operator keys (or just continue your calculations).  You may also acti-
vate this button by pressing the "$" on your keyboard. 

Make Topmost Window (Up Arrow button) 
Click this button if you want this screen to "float on top" of all other windows. 
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Time Entry 
 

Use this screen to enter time for Time/Date Calculation.  When you first open the 
Time Entry screen, it will show you current time. 
 
Hours, Minutes, Seconds 

Type in the proper values or use the 
up/down buttons. 

AM/PM 
If you are using the 12 hour mode, 
then you can use the up/down but-
tons to change the AM/PM value. 

24 Hour 
Check this box to use 24 Hour 
(Army) time.  Uncheck it to use the 
12 hour time.  The default is whatever your Windows Regional Settings show. 

Cancel Button 
Close the Time Entry screen. 

OK Button 
Close the Time Entry screen and pass the result to Time/Date Calculations. 

 
Calendar 

 
Use this screen to check the calendar or to choose a date for Time/Date Calculation.  
When you first open the calendar, it will show you the current date, then it will show 
you the last date you selected. 
 
The calendar is written in a manner where it is completely Y2K compliant. 
 
 
Month 

Chose a month to display.   
Year 

Choose a year to display.  You can choose 
any year between 1200 and 2200. 

Date 
Click on the date you wish to set (or see).  If 
you double-click on the Date, you will be able 
to add notes (tasks or comments) for his date. 

Cancel Button 
Close the calendar. 

Today Button 
Set the calendar to today's date. 

Find Button 
Search the Daily Notes for any information.  
The results of your search will be displayed in a new Scratch Pad window. 

Alarm Button 
This button allows you to open the Set Reminder Alarms screen right from the 
calendar. 

Make Topmost Window (Up Arrow button) 
Click this button if you want the Calendar to "float on top" of all other windows. 
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OK Button 
Close the calendar and pass the result back to the previous screen.  This button 
is visible ONLY when you use the Calendar to pass information. 

 
 

Date Notes/ RPN Stack/ Scratch Pad 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
DATE NOTES: Use this screen to add notes (up to 1024 characters) to any date.  
For example, we use this to keep notes on what work was performed and refer back 
to them when we are billing out the time Sheets.   
HINT:  This screen is available from the Calendar screen. 
 
RPN: In RPN Mode, you can view, but not edit, the RPN Stack on this screen. 
 
Scratch Pad: You can use this as a small text editor.  You can open multiple in-
stances of this editor. 
 

Applicable to Daily Notes, RPN and Scratch Pad Modes 
 
Bold 

Check this box if you wish the text to appear bold.  Settings will be retained until 
you change them again. 

Italic 
Check this box if you wish the text to appear italic.  Settings will be retained until 
you change them again. 

Font 
Select the font you wish to use.  Settings will be retained until you change them 
again. 

Font Size 
Select the size of the font (from 8 to 24).  Settings will be retained until you 
change them again. 

Print Button 
Print the text. 
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Find Button 
Search the text and highlight the found match. 

Find Next Button 
Continue the previous search. 

Open Button 
Open a saved text file. 

Save Button 
Save text to a file. 

Clock Button 
Insert the current date and time at the bottom of your text.  This is useful for 
keeping a log. 

Make Topmost Window (Up Arrow button) 
Click this button if you want this screen to "float on top" of all other windows. 

Exit Button 
Exit this screen. 

 
Applicable to Daily Notes Mode ONLY 

 
Save Daily Notes Button 

Save changes and exit. 
Delete Button 

Delete all notes for this date.  (Use to keep your file from growing to enormous 
proportions.) 

Alarm Button 
This button allows you to open the Set Reminder Alarms screen right from the 
Daily Notes screen.  If you select any text from your note (up to 35 characters) 
this text will be entered in to the Alarm Message box. 

 
Applicable to Scratch Pad Mode ONLY 

 
Log File 

You can keep a log file (same as Windows Notepad) by including the ".LOG" as 
the first 4 characters in your file.  When the Scratch Pad opens such file, it will 
immediately add the current date and time to the bottom of that text and allow 
you to start a new entry. 
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Reminder Alarms 
                                                                                                                                 
Use this screen to set your Reminder Alarms.  Alarms can be enabled or disabled 
from the Properties Menu. 
 
Type Of Alarm 

Select the type of alarm you wish to set. 
Message - A message that you entered will be displayed. 
File  - Launch a file.  Same as clicking on that file in the Windows Explorer. 
Program - Run a program. Same as using the Run command from the Start 
Menu. 
Keystrokes - Send keystrokes to a program that has the focus.  Same as typing. 

Type Of Execution (Once or Weekly) 
Select the type of alarm you 
wish to set. 
Once - This alarm will sound 
once on a certain date at a 
certain time and then will be 
erased. 
Weekly - This alarm will sound 
every predetermined day at a 
certain time.  It will not be 
automatically erased. 

Date 
If you selected the onetime 
alarm, you will be equired to 
set the date when this alarm 
should sound. 
NOTE:  You are not allowed to 
set a onetime alarm for the 
past. 

Days of Week 
If you selected the weekly alarm, you must select on which day(s) of week this 
alarm should sound. 

Alarm Message 
Enter a short message to display when this alarm goes off.  Active only if the 
Type of Alarm is set to Message. 

Open File 
Displays the file or URL that your alarm will open.  Active only if the Type of 
Alarm is set to File.  Double-Click to clear. 

Select File Button 
Click this button to select a file you wish to activate. 

Manual Entry Button 
Click this button to manually enter a file location or a URL of the file you wish to 
activate. 

Run Program 
Displays the program that your alarm will run.  Active only if the Type of Alarm is 
set to Program.  Double-Click to clear. 

Select Program Button  
Click this button to select the program you wish to launch. 

Manual Entry Button 
Click this button to manually enter a file location or command line parameters 
for the program you wish to launch. 
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Keystrokes 
Enter the codes for the keystrokes you want to send.  Active only if the Type of 
Alarm is set to Keystrokes. 

Time 
You must set a time when this alarm should sound. 

Submit Button 
After you entered the information for a new alarm, click this button to add this 
alarm to the list. 

Delete Button 
Select an alarm from the list and click this button to remove it. 

Exit Button 
Exit this screen. 

List of Existing Alarms 
This is a list of existing alarms.  The list is sorted by date and time, therefore 
your weekly alarms will appear at the end of the list (sorted by day in alphabeti-
cal order).  If you double-click on an alarm, the Reminder Message for that 
alarm will appear in one of the message boxes. 

Alarm Sound File 
Click the Open button at the bottom of this screen to select a sound (wav) file to 
play when sounding the alarm. 

Make Topmost Window (Up Arrow button) 
Click this button if you want this screen to "float on top" of all other windows. 

 
Sending Keystrokes with Alarms 

 
Use these codes to send keystrokes to applications at a predetermined time.  This 
only applies to the Reminder Alarms. 
 
The plus sign (+), caret (^), percent sign (%), tilde (~), and parentheses () have spe-
cial meanings. To specify one of these characters, enclose it within braces ({}). For 
example, to specify the plus sign, use {+}. Brackets ([]) have no special meaning, 
but you must enclose them in braces. To specify brace characters, use {{} and {}}. 
 
To specify characters that aren't displayed when you press a key, such as ENTER or 
TAB, and keys that represent actions rather than characters, use the codes shown 
below: 

                Key                                                                 
                BACKSPACE                                                          F1 
                    BREAK                                                                    F2 
                    CAPS LOCK                                                           F3 
                    DEL or DELETE                                                     F4 
                    DOWN ARROW                                                   F5 
                    SCROLL LOCK                                                     F6 
                    ENTER                                                                    F7 
                    ESC                                                                          F8 
                    HELP                                                                       F9 
                    HOME                                                                    F10 
                    INS or INSERT                                                       F11 
                    LEFT ARROW                                                       F12 
                    NUM LOCK                                                           F13 
                    PAGE DOWN                                                        F14 
                    PAGE UP                                                                F15 
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                    PRINT SCREEN                                                     F16 
                    RIGHT ARROW                                                    END 
                    UP ARROW                                                           TAB 
                                                            Codes 
                    {BACKSPACE}, {BS}, or {BKSP}                       {TAB} 
                    {BREAK}                                                                {UP} 
                    {CAPSLOCK}                                                        {F1} 
                    {DELETE} or {DEL}                                            {F2} 
                    {DOWN}                                                               {F3} 
                    {END}                                                                    {F4} 
                    {ENTER}or ~                                                        {F5} 
                    {ESC}                                                                     {F6} 
                    {HELP}                                                                  {F7} 
                    {HOME}                                                                {F8} 
                    {INSERT}                                                               {F9} 
                    {LEFT}                                                                   {F10} 
                    {NUMLOCK}                                                        {F11} 
                    {PGDN}                                                                 {F12} 
                    {PGUP}                                                                  {F13} 
                    {PRTSC}                                                                {F14} 
                  {RIGHT}                                                                {F15} 
                    {SCROLLLOCK}                                                  {F16} 
 
To specify keys combined with any combination of the SHIFT, CTRL, and ALT keys, 
precede the key code with one or more of the following codes: 
              Key                      Code 
                SHIFT                      + 
                CTRL                       ^ 
                ALT                         % 
 
To specify that any combination of SHIFT, CTRL, and ALT should be held down 
while several other keys are pressed, enclose the code for those keys in parenthe-
ses. For example, to specify to hold down SHIFT while E and C are pressed, use "+
(EC)". To specify to hold down SHIFT while E is pressed, followed by C without 
SHIFT, use "+EC". 
 
To specify repeating keys, use the form {key number}. You must put a space be-
tween key and number. For example, {LEFT 42} means press the LEFT ARROW 
key 42 times; {h 10} means press H 10 times. 

 

Project Timer 
 
This feature is primarily for professionals who bill their labor on an hourly basis. 
 
The timer Start/Stop button is located on the main Calculator screen, to the left of 
the Number Lock indicator.  It looks like a Stop Watch. 
 
To Start the timer, click the timer button.  The button will remain depressed until you 
click it again.  Clicking the button a second time will stop the timer and print the re-
sult to tape.  You can also start and stop the Project Timer from the File Menu on the 
main screen or from the Tray Menu. 
 
To set up you hourly rate, use the Set Billing Rate option from the Edit Menu or the 
Billing Function on the Time/Date Calculation screen.  Once you set the Hourly 
Rate, it will remain in the system until the next time you change it. 
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Registration Screen  
 
 
This screen is used to register the CDML Advanced Calculator. Please use the 
Registration Form to calculate the proper registration amount. 
 
 
 
 
 
 
 
 
 
 
 
 
Why Register 

There are several reasons why you should register the CDML Advanced 
Calculator.   You must register the calculator to unlock all features (applies to 
the ShareWare version only). 
⇒ The primary reason is to become eligible for Technical Support and product 

upgrades. 
⇒ The second reason is to enable all of the available functions (some of them 

are disabled in the unregistered version). 
⇒ The third reason is so that we can notify you of new releases and other 

pertinent information. 
⇒ The forth reason is to let the developers know that you appreciate their 

efforts and you would like to see further development of the calculator, as 
well as additional products from CDML Computer Services. 

⇒ The final reason is to comply with the Licensing Agreement. 
 
User Name 
       Enter your name here.  The name must be anywhere from 2 to 30 characters 

long. 
Serial Number 

Once you have entered your user name, you must enter the Serial Number.  
This number can be found on the original distribution media. 

Register On-Line 
       You can use our online registration form. This will immediately place you on  
       our product notification list. 
 
Once you have entered the User Name and the Serial Number, press the Register 
(Happy Face) button to finish the registration process. You can also press the 
Cancel (Stop Sign) button to abort the registration process. 
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Technical Support 

 
Support  by Phone 
              Registered users will receive FREE telephone support during regular busi 
              ness hours (10:00am to 5:00pm EST).  This support is available for the first  
              60 days from the date of registration.   
 
              After the initial 60 days, telephone technical support will be available on a  
              paid basis of $20.00 per incident (payable by credit card). 
 
              Contact telephone number:  (718) 786-4433 
 
Support  by Email 
              Registered users will receive FREE UNLIMITED technical support by email.   
              All questions will receive a response within 96 hours. 
 
All suggestions should be directed to : hlpatcdml@aol.com 
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Glossary 
 
Annuity 

series of fixed cash payments made over a period of time. An annuity can be a loan (such 
as a home mortgage) or an investment (such as a monthly savings plan). 

Argument 
requested parameter (such as a value or a percentage rate) which you must provide.  
(NOTE:  Used in financial functions.) 

Asset 
item or property which may depreciate. 

Cash 
meaning an amount of money 

Depreciation 
decrease in value due to wear and tear, decline in price, etc 

Double-Declining Balance Method 
depreciation at an accelerated rate. Depreciation is highest in the first period and de-
creases in successive periods. 

Fixed 
does not change. 

Interest 
sum paid or charged for the use of money or for borrowing money 

Interest Rate 
expressed as a percentage of the amount borrowed to be paid over a given period (usually 
one year). 

Internal Rate of Return 
interest rate received for an investment consisting of payments and receipts that occur at 
regular intervals. 

Modified Internal Rate of Return 
internal rate of return when payments and receipts are financed at different rates. 

Net Present Value of Investment 
current value of a future series of payments and receipts 

Operand 
number that an Operator will perform action on. (i.e. In the expression "2+3", "2" and "3" 
are operands and "+" is the operator.) 

Payment 
amount of money you pay out. 

Periodic 
at regular intervals (such as monthly). 

Principal 
capital sum, as distinguished from interest or profit. An example of this would be the origi-
nal investment amount. 

Readout 
portion of the CDML Advanced Calculator located between the Tape Display and the but-
tons. The Readout reflects your numeric input and results of your calculations 

Receipt 
amount of money you are paid by somebody else. Also, may refer to a document serving 
as proof of purchase. 

Tape Display 
computer equivalent of the tape on an adding machine. Used to review or annotate your 
calculations. 

ToolTips 
box showing a value or an explanation for a control on the screen. To view the ToolTips, 
place your mouse over the control and leave it there for a few moments. The ToolTip win-
dow will appear automatically. 
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About CDML Computer Services, Ltd. 
 

We, at CDML Computer Services, Ltd. pride ourselves on the fact that we are able to minimize 
our customers' computer problems! For years we have been providing services ranging from 

basic hardware installations to custom software solutions and everything in between (including 
networking and accounting/POS solutions). Our experienced staff of Technicians, 

Programmers and Network Specialists will be able to quickly analyze and eliminate your 
computer problem, regardless of what it is. 

 

 

CDML Software Packages 
 

Real Estate Sales Tracking System© (R.E.S.T.S.) - software for Real Estate marketing 
Cargo Tracking System©  (C.T.S.) - software for Freight Forwarders and NVOCC 
Telephone Order Entry System©  (T.O.E.S.) - automated, computer assisted telephone order 

placement and processing system 
CDML Auto Dealer©  - Sales Tracking and Automation for Used Car Lots. 
CDML Tank Cleaning©  - software for water/oil tank cleaning and maintenance companies. 
CDML Universal Bookmark Manager (U.B.M.)©  - Internet bookmark manager for sharing 

bookmarks between Internet Explorer, Netscape Navigator and Opera browsers. 
CDML Advanced Calculator©  - a calculator with tape display, memory functions, conversion 

functions and financial functions. 
 

CDML Computer Services, Ltd. 
29-28 41 Ave., Suite 707 

Long Island City, NY  11101 
                            Tel. (718) 786-4433           URL:  www.cdml.com 
                            Fax (718) 786-4554           E-mail:  sales@cdml.com 

Onsite & In-house Computer Repair 
Business & Accounting Software 

User Training Services 
Software Sales and Support 

Maintenance Contracts 
Computer-Telephone Integration 

Network Administration & Support 
General Computer Consulting 
Hardware Sales and Support 

Internet/Intranet Solutions & Services 
Support via Voice and/or Computer 

Custom Programming 

We provide a variety of services 

Hardware Authorizations Software Authorizations 

Hewlett Packard 
IBM 

Lexmark  
Toshiba 

SMC 
Acer 

and many others 

Novell 
Microsoft 

Sage/State Of The Art, Inc. 
Computer Associates/Cheyenne 

CAP Automation 
Artisoft 

and many others 

We represent many Manufacturers and Developers 

BusinessWorks Accounting 
Peach Tree Accounting 

MAS 90 Accounting 
SellWise Point Of Sale 

We offer Accounting and Professional Software Packages 

mailto:sales@cdml.com
http://www.cdml.com
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Copyright/Licensing 
 
 
(c) 1994-1999 CDML Computer Services, Ltd. All rights reserved. 
CDML Computer Services, Ltd. 
29-28 41 Avenue, Suite 707 
Long Island City, NY  11101 
Tel. (718) 786-4433   Fax (718) 786-4554 
 
User License: 
This program and documentation are copyrighted and may not be altered, modified or reverse engineered. For more information contact CDML 
Computer Services, Ltd. 
 
CDML Advanced Calculator may not be sold, distributed or used in any other manner without the prior written consent of CDML Computer Services, Ltd. 
Those interested in licensing CDML Advanced Calculator for other than personal use should contact CDML Computer Services, Ltd.  
 
Lawful users of this software are hereby licensed only to read the software on the enclosed diskette(s), CD(s) or other electronic media from their 
medium into the memory of a computer. 
 
TRADEMARKS 
CDML, C.T.S.©, Cargo Tracking System©, CDML R.E.S.T.S.©, Real Estate Sales Tracking System©, FaxPrint for BusinessWorks©, CDML 
AutoDealer©, CDML T.O.E.S.©, CDML Telephone Order Entry System© and CDML Advanced Calculator©  are trademarks of Leonard Kaplan and 
CDML Computer Services, Ltd. All other trademarks and registered trademarks are trademarks or registered trademarks of their respective holders. 
 
United States: 
This License is your proof of license. Please treat it as valuable property. 
 
CDML END USER LICENSE AGREEMENT (THE "AGREEMENT") 
 
NOTICE TO END USER: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT. USE OF THE SOFTWARE (THE "SOFTWARE") PROVIDED 
WITH THIS AGREEMENT CONSTITUTES YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS 
AGREEMENT, PROMPTLY RETURN THE SOFTWARE AND THE ACCOMPANYING ITEMS (INCLUDING WRITTEN MATERIALS, BINDERS AND 
CONTAINERS) TO THE LOCATION WHERE YOU OBTAINED THEM FOR A FULL REFUND. 
 
1. License Grant. CDML Computer Services, Ltd. and Leonard Kaplan ("CDML") grant to you (either as an individual or entity) a nonexclusive sublicense 
subject to the provisions hereof  
(a) to use the SOFTWARE solely for your own internal personal or business purposes,  
(b) you may install and use one copy of the SOFTWARE on a single computer,  
(c) a single license may not be used concurrently by more than one user,  
(d) a single license may not be used concurrently on more than one computer,  
(e) you may not rent, lease, or lend this SOFTWARE,  
(f) you may permanently transfer all of your rights under this AGREEMENT, provided you retain no copies, you transfer the SOFTWARE in full 
(including all media and printed materials), and the recipient agrees to the terms of this AGREEMENT. If this SOFTWARE is an upgrade, you must 
include all prior versions of this SOFTWARE in the transfer. 
(g) you may make and maintain two (2) copies of the SOFTWARE for backup. All the information appearing on the original disk labels (including the 
copyright notice) must be copied onto the backup labels. 
 
2. Proprietary Rights. You acknowledge that the SOFTWARE is proprietary to CDML and its suppliers. 
 
3. Ownership. Except as stated above, this Agreement does not grant you any rights to patents, copyrights, trade secrets, trade names, trademarks 
(whether registered or unregistered), or any other rights, franchises, or licenses in respect of the SOFTWARE. Title to and ownership of the 
SOFTWARE, any reproductions and any documentation shall remain with CDML and its suppliers. You will not adapt or use any trademark or trade 
name which is likely to be similar to or confusing with that of CDML or any of its suppliers or take any other action which impairs or reduces the 
trademark rights of CDML or its suppliers. 
 
4. Other Restrictions. This Agreement is your proof of license to use the SOFTWARE in accordance with these terms and must be retained by you. You 
may not rent or lease the SOFTWARE. YOU MAY NOT ALTER, MODIFY, REVERSE ENGINEER, DECRYPT, DECOMPILE, OR DISASSEMBLE THE 
SOFTWARE. 
 
5. Customer Remedies. CDML's entire liability and your sole and exclusive remedy shall be, at CDML's option, either to (a) correct the error, (b) help the 
end user work around or avoid the error or ( c) authorize a refund, so long as the SOFTWARE, printed materials and/or computer media are returned to 
CDML with a copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE has resulted from accident, abuse, or misapplication. A 
refund may be authorized ONLY for packages where the protective seal has not been broken. 
 
6. No Other Warranties. CDML DOES NOT WARRANT THAT THE CDML SOFTWARE IS ERROR FREE. CDML DISCLAIMS ALL WARRANTIES, 
EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OR MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NON INFRINGEMENT OF THIRD PARTY RIGHTS WITH RESPECT TO THE SOFTWARE, THE ACCOMPANYING 
WRITTEN MATERIALS OR MEDIA. AS ALLOWED BY APPLICABLE LAW. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES OR LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY MAY LAST, OR THE EXCLUSION OR LIMITATION OF INCIDENTAL 
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR  EXCLUSIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU 
SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO JURISDICTION. 
 
7. Severability. In the event of invalidity of any provision of this Agreement, the parties agree that such invalidity shall not affect the validity of the 
remaining portions of this Agreement. The United Nations Conventions on Contracts for the International Sale of Goods is specifically disclaimed. 
 
8. No Liability for Consequential Damages. IN NO EVENT SHALL CDML BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL 
OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE USE OF THE SOFTWARE, EVEN IF CDML HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL CDML'S LIABILITY FOR ANY CLAM, WHETHER IN CONTRACT, OR ANY OTHER 
THEORY OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU. 
 
9. Entire Agreement. This is the entire agreement between you and CDML which supersedes any prior agreement, whether written or oral, relating to the 
subject matter of this Agreement. 
 
10. Registration. You must register the SOFTWARE with CDML Computer Services, Ltd. Registration entitles you to technical support, free upgrades to 
all future maintenance releases for the same major version of the SOFTWARE, and discounted upgrades to future versions. 
 
By using this SOFTWARE, you are agreeing to the above terms. 
 
Should you have any questions concerning this Agreement, or if you desire to contact CDML for any reason, please write to:  
CDML Computer Services, Ltd., 29-28 41 Avenue, Suite 707, Long Island City, NY  11101. 
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